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Copyright
Copyright 2004-2006 Raritan Inc.

All rights reserved.

Peppercon AG

Scheringerstr. 1
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Version: 1.6
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Trademarks
This publication contains proprietary information which is protected by copyright. No part of this
publication may be reproduced, transcribed, stored in a retrieval system, translated into any language or
computer language, or transmitted in any form whatsoever without the prior written consent of the
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Raritan acknowledges the following trademarks:

• Intel is a registered trademark of Intel Corporation.
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Preface

This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/ ).

Authors: Raritan Team

About the KVM Vision Viewer
The KVM Vision Viewer offers fully transparent remote console facilities, which allow you to see the
screen as the remote system boots or to see console messages during normal operation. The KVM Vision
Viewer allows you to remotely �nd and administer all of the Raritan remote management devices on
your network.

Limited Warranty
The buyer agrees that if this product proves to be defective,Raritan is only obligated to repair or replace
this product at Raritan's discretion according to the termsand conditions of Raritan's general trading
conditions.

Raritan shall not be held liable for any loss, expenses or damage, directly, incidentally or consequentially
resulting from the use of this product. Please see the Warranty Information shipped with this product for
full warranty details.

Limitations of Liability
Raritan shall in no event be held liable for any loss, expenses or damages of any kind whatsoever,
whether direct, indirect, incidental, or consequential (whether arising from the design or use of this
product or the support materials provided with the product). No action or proceeding against Raritan may
be commenced more than two years after the delivery of the product to the buyer.

The licensee agrees to defend and indemnify Raritan from anyand all claims, suits, and liabilities
(including attorney's fees) arising out of or resulting from any actual or alleged act or omission on the
part of Licensee, its authorized third parties, employees,or agents, in connection with the distribution of
Licensed Software to end-users, including, without limitation, claims, suits, and liability for bodily or
other injuries to end-users resulting from use of Licensee's product not caused solely by faults in
Licensed Software as provided by Raritan to Licensee.
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Chapter 1. The Quick Start Guide

General Remarks
The KVM Vision Viewer (henceforth:Vision Viewer) is a program which runs on your Windows based
PC. TheVision Viewerallows you to access the remote console screen over the TCP/IP network. You get
a full view of the screen and you can operate the keyboard and mouse remotely from your PC. This
makes remote installation and troubleshooting a lot easier, as you can look at the remote systems console
without using the SneakerNet.

It will also allow you to detect any Raritan device on your local network (for example ASMI or OPMA
modules). With the aid of theVision Vieweryou can then con�gure your Raritan devices and assign them
to groups. You can then manage clusters of devices as a group which makes things easier and more
ef�cient for you.

A Note about Devices
TheVision Viewerwill �nd your devices and it will place them into two default groups. This little section
here is important so that you can understand how theVision Viewerwill deal with devices.

Normally, or rather very often, customers have a DHCP servercon�gured on their LAN. Our RMDs are
usually shipped with the DHCP boot option being enabled (this may not be the case if you speci�ed
otherwise in case you are an OEM customer). In other words, once the RMD is powered up it will
receive an IP-address and other information pertaining to the network from your DHCP server.

However when you start up theVision Viewer, you will �nd that the RMDs detected by theVision Viewer
are placed in a default group called "Uncon�gured Devices".They are shown in the tree view by their
Ethernet MAC address (and a yellow question mark) -despite the fact that they are already "equipped"
with an IP-address using DHCP. But theVision Viewerdoes not yet "know" the device. Therefore, the
RMD is shown in the "Uncon�gured Devices" group in the tree view of theVision Viewer.

In order to get to know the device theVision Viewerhas to either "query" the device or "con�gure" it.
These are menu options of theVision Viewerwhich are discussed in the later chapters. Querying the
device will check if it already has an IP-address. Con�guring the device will allow you to either set an
individual IP-address or instruct the RMD to fetch one from the DHCP server.

Once the RMD has been queried or con�gured, it will have an IP-address in the tree view. It will also
move immediately from theUncon�gured Devices group to become a member of theNew Devices
group. Therefore do not worry if devices suddenly "vanish" -they are not lost, just in a different view of
the tree view.

Some Sample Screenshots
When you open theVision Vieweryou will see the normal tree view. This looks a little bit likethe
Microsoft Management Console (MMC) for Windows Servers.
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Chapter 1. The Quick Start Guide

The tree view displays all Raritan devices it �nds in a hierarchial fashion. New (i.e. unknown) devices
are clearly marked as uncon�gured devices.

Figure 1-1. Opening Screen of the KVM Vision Viewer
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Chapter 1. The Quick Start Guide

When you open the remote console to access a system on your network, you will see a screen such as
this:

Figure 1-2. Remote Console (Typical View)

Installing the KVM Vision Viewer
TheVision Vieweris supplied as a self-extracting archive �le. You should have received a �le called
"KVM Vision Viewer.exe"or a similarly obvious name.

In order to install theVision Viewer, you simply need to run (or double-click) the �le. You will then see a
familiar and customary install wizard for Windows. In orderto use theVision Viewerquickly, simply
accept all the suggested defaults and you are all set.

The �nal install screen allows you to immediately invoke theVision Viewerif you are impatient.
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Chapter 2. Installation of the KVM Vision Viewer

Using the Install Wizard for the KVM Vision Viewer
Once you have received theKVM Vision Viewer.exe�le, you can install theVision Viewerby simply
running the �le. You can do this by either using the Windows "Run" function or by simply
double-clicking the �le. Once you have done so, you will be greeted by the �rst install wizard screen:

Figure 2-1.Vision ViewerSetup Wizard Welcome Screen

When you click NEXT, you will see a screen informing you of thesystem requirements needed in order
to successfully install and use theVision Viewer:

4



Chapter 2. Installation of the KVM Vision Viewer

Figure 2-2. System Requirements Info Screen

When you are certain that your system meets the requirementsthen please con�rm this by clicking
NEXT. The Choose Components Screen will appear.
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Chapter 2. Installation of the KVM Vision Viewer

Figure 2-3. Choose Components Screen

The above screen allows you to specify the components of theVision Viewerwhich you want to install.
You should select a normal installation. Additionally you can choose to install different visual
components which will inhabit your screen. When requested theVision ViewerSetup will create a
desktop shortcut, an entry in the "Start" menu and an icon in the Quick Launch bar.
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Chapter 2. Installation of the KVM Vision Viewer

Figure 2-4. Choose Install Directory Screen

You will then be asked to enter a target installation directory in this screen.

The directory suggested as the default is usually �ne, so just click INSTALL in order to start the
installation of theVision Viewerin the speci�ed directory. Of course you may enter a different location if
you so wish - in that case you can roam the �le system of your PC using the BROWSE button next to the
directory text �eld.

The installation will commence and once the �le has been unpacked and the �les copied to the right
place, you will see a �nal screen:
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Chapter 2. Installation of the KVM Vision Viewer

Figure 2-5.Vision ViewerInstallation Completed Screen

If you are in a hurry (as usual :-)) and want to get started right away, you can tick the box and then invoke
theVision Viewerimmediately. Once you have clicked the FINISH button, theVision Viewerwill start up
and display an empty tree view:

Figure 2-6.Vision ViewerInitial Tree View Screen
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Chapter 3. The Remote Console: Care and
Feeding

Introduction
One of the key features of theVision Vieweris the remote console (henceforthRC). It allows direct
access to the console input and output of the remote system which hosts the RMD. You can use devices
like the keyboard and mouse directly as well, this makes remote administration a lot easier. Very often
when you wish to install a system the installation bootstraps and install programs speak only to the
system console (it is the only device they can be sure of). Using theRCfunction of theVision Viewer
allows you to also install systems remotely.

A typical RClooks like this:

Figure 3-1. Typical View of the Remote Console
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Chapter 3. The Remote Console: Care and Feeding

Note: You can access the RC in several ways. The above screenshot shows the RC opened in a
so-called Extra Window. The Vision Viewer opens such a window when you either select the
apropriate menu item in the Vision Viewer or by double-clicking on the device entry in the tree view.

The Remote Console Menu Buttons
There are several function buttons in the task bar at the top of theRC. Here is a short list of the function
buttons as well as their functions.

Exit - this button allows you to exit theRC. Note: it closes the remote console window ONLY, the
Vision Viewerwill remain active.

Monitor Only - this button connects theRCto the remote host for video only. The input devices
(keyboard and mouse) are ignored.

Disabled Monitor Only - this is the view for the Monitor Only button, when it is disabled. This is
the case if you have already selected anRCmode which uses the inputs - like one of the mouse
modes or the soft keyboard.

Exclusive Access -this is necessary if you need to be alone with your remote host. Our RMDs
allow several admins to be logged on at the same time, but if you wish to do something critical, you
usually want to be the only user on the RMD. Clicking this button will make you the only user on
the RMD. It is a good idea to warn the other users, in case they themselves are doing something
important. Clicking this button without prior warning is de�nitely considered rude!

Exclusive Access Granted -this is the button you see if you have successfully terminated the other
user sessions.

10



Chapter 3. The Remote Console: Care and Feeding

Full Screen Mode -use this button to expand theRCwindow to use the full screen. If you wish to
return to your own screen again, please use the CTRL-F10 key combination (see the "hint" below).

Figure 3-2. Full Screen Mode Escape Sequence Hint

Please take note that the Ctrl-F10 key is only a default setting. You can adjust this key code in the
Display Settings->Hotkeysmenu. Also you can toggle the Hotkey behavior using the Full Screen
Message option.

Capture Screen Shot -the camera button allows you to take a screenshot of the selectedRC
window. When you select this button, you are asked to enter a place to store the screenshot in a

11



Chapter 3. The Remote Console: Care and Feeding

pop-up box. You can also select the bitmap type to be saved: JPEG or BMP.

Figure 3-3. Screenshot File Location Box

Hot Keys - here you can send special key combinations like Ctrl-Alt-Del to the remote host. You
cannot send such keys if you have enabled "Monitor Only" (seeabove). When you click the
Hotkeys button, you will see the possible key codes in a small"slave display" suchly:

12



Chapter 3. The Remote Console: Care and Feeding

Single Mouse Mode -here you can switch to having a single mouse pointer. Your local mouse
pointer is hidden and you only see the remote mouse pointer.

Double Mouse Mode -this is the button you need in order to get into Double Mouse Mode. Double
mouse mode means that you have one mouse pointer for your own desktop and one in theRC. Both
mice thus have to be synchronized. The mouse pointer for theRCis constrained to remain in theRC
window. Only your local mouse can "leave" theRCwindow.

Sync Mouse -synchronises your local mouse pointer with the remote systems mouse pointer that is
visible in theRC. Needed to properly use Double Mouse Mode.

Soft Keyboard - this is the button to pop up the Soft Keyboard. This is shown below and is
explained in more detail in Chapter 5.

Options Menu Button - Opens the Options drop-down Menu. See the next section.

Note: All of the functions available on the task bar are also available using the Options Menu,
which you access using this button.
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Chapter 3. The Remote Console: Care and Feeding

The Options Button Menu
As mentioned above the buttons shown in theRCtask bar are also available in the Options Menu that is
accessible using the OPTIONS button. However the Options Menu offers some extra options which you
cannot access directly via the task bar.

Note: Should you have turned off the Tool Bar in the Display Options by mistake you can get back to
this menu by right-clicking into the Vision Viewer Title Bar!

They are the following:

• Display Options

• Connection Options

• Preferences

• About KVM Vision Viewer...

The �gure below shows the opened Options drop-down menu:
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Figure 3-4. Options Menu opened in theRC
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Chapter 3. The Remote Console: Care and Feeding

Figure 3-5. Selecting Display Options

Above you can select the display options menu.
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Chapter 3. The Remote Console: Care and Feeding

Display Options Pop-Up
The following display options are displayed, most of the categories shown on the rider tabs are familiar
to you from the task bar:

Figure 3-6. Display Options General Pop-Up Menu

On top the normal functions you can set the screens refresh rate. This is normally "off" as you are
normally on a LAN. When you are on a different connection typeyou may have turned up the Noise
Filter. If you turn the Noise Filter up, your mouse pointer may leave a trail. If you then set the refresh
rate, this trail will be erased by the automatic screen refresh.

Additionally you can specify an idle time, after which theRCwill automatically be closed.

17



Chapter 3. The Remote Console: Care and Feeding

Figure 3-7. Setting Options for Different Mice

The mouse options allow you to specify how to use mice with different button con�gurations. For
example you might be using a three-button mouse attached to your PC but the remote system might
"expect" to hear input from a two-button mouse.
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Chapter 3. The Remote Console: Care and Feeding

Figure 3-8. Display Options Local Cursor Menu

This tab allows you to control the shape of the local cursor.
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Chapter 3. The Remote Console: Care and Feeding

Figure 3-9. Dispay Options Hotkeys Menu

The Hotkeys menu allows you to set special hotkeys in order toswitch theRCto Full Screen Mode and
back into normal mode. You can also de�ne a hotkey to exit theRCentirely.
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Figure 3-10. Con�guring OSD Behavior

OSD Messages are messages that pop up on yourRC. There are several types of OSD messages. Some
are generated by the remote system and are sent to your screenvia the RMD. A typical message might be
"NO SIGNAL" if the remote computer detects no video signal atthe console.

Other messages are status messages from theVision Viewer. Such messages could be like the "Leaving
Exclusive Access Mode" shown in the Status Line (the last line) in the above screen shot or something
like "Mouse Sync Successful".

This tick-box allows you to set how to deal with such behavior. You can disable theVision ViewerOSD
messages. This disables any messages from theVision Viewercoming through, you will still see the
messages generated by the RMD. You can set their color and transparency.
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Figure 3-11. Scaling Options

The Scaling Menu allows you to adjust the size of theRCwindow.
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Connection Options Menu
The Connection Options Menu allows you to tune the remote connection.

Figure 3-12. Opened Connection Options Menu
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Chapter 3. The Remote Console: Care and Feeding

Figure 3-13. Connection Options Pop-Up Menu

When you select the Connection Options, you will see the above pop-up menu. You can select the
preferred encoding of the video data. TheRCcan either detect this automagically or you can set a �xed
encoding. If you choose to �x your own method you can also set the connection parameters in a more
detailed fashion by selecting the ADVANCED option.

You can also select Exclusive Access for yourRCconnection. As mentioned above, this will make you
the only user accessing the remote RMD.
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The Preferences Menu
This is the view of theRCwith the Preferences Option selected:

Figure 3-14. Selecting the Preferences Menu
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Figure 3-15. Preferences Pop-Up Menu

The above pop-up appears once you have selected the Preferences Menu. You can choose various
settings.

Remote Console Preferences Menu

The drop-down Con�guration Menu shows the "Remote Console Preferences Menu" underneath the
previously discussed "Options" menu.

This menu item opens another pop-up. It allows you to con�gure the look and behaviour of the Remote
Console window to a �ner degree.
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Figure 3-16. Con�guration Preferences Menu

The above pop-up window allows the following settings:

• Tool Tips Help - this allows you to enable or disable the dynamic help menus.Also you can adjust the
form of the help, the default being the normal "ballon" look.
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Figure 3-17. Remote Console Style Preferences

• Full Screen Message- this controls a helpful Message Box giving you a hint on how to leave the
Extra Window, in case you have selected Full Screen mode. When the Extra Window of theRC�lls
the entire screen, then the buttons to close or control it arenot visible. TheAlways setting will allow
the hint ("Press Ctrl-F10...") to be displayed in a pop-up box. Nevermeans that you never wish to see
the Message Box.Skip on Hotkey or Toolbar displays the hotkey hint only if you opened the Full
Screen Extra Window using the menu. If you opened the Full ScreenRCusing the Toolbar or Hotkey,
then the hint will not appear.

• Saving Session Preferences- theVision Viewersaves some of its & rc con�guration settings in the
Registry. Using this option you save the settings pertaining to your remote session, for example
display and mouse settings.

Note: These are saved for each device. The Vision Viewer will remember the RC preferences and
settings for each RMD.
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Chapter 3. The Remote Console: Care and Feeding

• Special Windows Keys Behaviour- Windows knows some special key codes, like CTRL-ALT-DEL
etc. This option controls how theVision Viewerwill deal with them. The default is that special keys
get handled by the local PC and will not be transmitted to the Remote Host. The other points allow
you to transmit them to the remote host or both.

• Show Toolbar - simply choose whether you want to permanently see the tool bar.

• Status Bar - toggle if you wish to see the status bar or not.

• Rendering Options- this controls the rendering of the images from the remote device in the
Observation Window or Extra Window. The problems arise if weneed to scale the image received up
or down for display on your PC. Bear in mind that the remote system might have a larger or smaller
screen than your PC.

Basically you will encounter two situations: either you want to open theRCand scale the picture up or
down in order to �t your screen for example OR you simply want to see theRCone-to-one.

For the latter case you should "Use 2D Rendering": this meansthat theRCwill use the Microsoft
Windows Software rendering functions to render the image. This is actually fastest, given that you do
not need any image scaling.

For scaling you should "Use Direct 3D" - however this needs a powerful graphics card to work nicely.
If you have a slow PC but a fast graphics card, this is the best option. However please note that it is
fastest only for a SINGLE remote device display.

Or you can "Use Software Rendering" - this setting enables some very fast propietary Raritan scaling
code to be used. The image painting is then handled by the Windows operating system. In order to
achieve good performance you really need a fast PC for this option, but you can use it well for viewing
severalRCwindows at once.

• Proxy Settings- by clicking the CHANGE PROXY SETTINGS button you will �nd a pop-up menu
to change the settings for the Web Browser proxy.

Proxy settings are necessary because theVision Vieweruses the HTTP (Web) Protocol to establish the
initial connection to the RMD. Furthermore theVision Vieweruses the HTTPS (Secure Web) port
number 443 (the default) in order to authenticate theRCuser. Once the connection is established the
RMDs still use the same ports to transmit our own propietary protocols because they are usually
allowed to be used through �rewalls and proxies within a company.
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Figure 3-18. Proxy Settings

• Reset to Defaults- if you regret all your playing around with all the options, this button allows you to
return to our factory defaults. Instant sanity at the click of a button :-)
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Message Window
Normally theVision Viewercollects all status and OSD messages and displays them in a special message
window. You can access this to see the messages:

Figure 3-19. Selecting the Message Window
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Once you have selected this, you will see the Message Window popping up. It generally shows only the
last message. Previous messages are available to you by inspecting the internal log�le by clicking the
LOG button.

Figure 3-20. Message Window in the Remote Console

Here is a view of the log�le:
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Figure 3-21. The Log�le is being displayed

Connection Info
Selecting this option...
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Figure 3-22. Selecting Connection Info

...will display a little Info box with some data about your connection to the RMD.
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Figure 3-23. Connection Info Box
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Mouse Handling Menu
When you select the Mouse Handling Option you can choose different methods to keep your mouse in
synchronicity with the remote mouse (or vice versa).

Figure 3-24. Mouse Handling Menu

Using the Soft Keyboard
The Soft Keyboard Option unfolds a small sub-menu. The SHOW option simply displays a soft keyboard
pop-up.

Take heed that the Soft Keyboard is actually thekeyboard type of the remote host! This is actually
very useful: for example if you are connected to a remote hostin Japan (with a japanese keyboard) from
your of�ce in the USA, you will �nd that it is extremely dif�cult if not impossible for you to generate
key presses in Japanese. The Soft Keyboard will open a "remote local keyboard" and you can use it to
enter the Japanese.
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Figure 3-25. Soft Keyboard Sub-Menu

The Mapping entry allows you to change the keyboard mapping.This is very useful if your PC and the
remote system are using a different input locale and keyboard layout.
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Figure 3-26. Keyboard Mapping Menu
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The CAPS LOCK Behavior menu allows you to set how theRCmaps your CAPS LOCK key to the
remote system.

Figure 3-27. CAPS LOCK Mode Menu
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About KVM Vision Viewer...
The �nal menu entry displays some information about theVision Viewer.

Figure 3-28. Selecting KVM Vision Viewer Information
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Chapter 4. Using Groups

Introduction to Groups
UsingVision Vieweryou can bundle the RRMs found on your network into managementgroups. This
makes managing them a lot easier. Note that the groups are simply a virtual management tool. Currently
there is only one way where the group concept helps you on a physical device level, this is when you
open a remote connection to all of the devices in a group, as explained below.

Below the Group Menu, you can see another group menu:New IPMI Group . This allows you to enter
the "IPMI only" RMDs here. These are devices which are only accessible using IPMI over Ethernet.

Note: The Vision Viewer will allow you to also enter devices which use IPMI over Ethernet that are
not manufactured by Raritan. Of course you cannot administer such devices using the Vision Viewer,
however you can include them into the IPMI group and open connections to them using IPMI over
Ethernet, as this is not a propietary standard.

In the sense of groups, using a group name, you can open a remote connection to all of the devices in a
group. This is true for "normal" device groups ONLY! It will NOT work for IPMI devices in a group.

In order to achieve this, select the desired group, either a normal or an IPMI-only group and select the
menu item "Connect All Devices".

The Group Menus
The �gure below is the opened group menu:

Figure 4-1. Groups Menu
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Figure 4-2. Creating a new group

Select the item above to enter a new group name. In our examplethis is "test".

Figure 4-3. The New Group is available

And -surprise, surprise- :-) the new group appears in the tree view.
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Figure 4-4. Renaming a Group

The item above lets you rename a group.

Figure 4-5. Renaming the Group to "test"

The new name for the group has to be entered in the dialog box.
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Figure 4-6. Deleting a Group

Deleting a group is just as simple - see above.

Select the group to be deleted, currently we only have the onecalled "test":

Figure 4-7. Deletion of group "test"

Result of the group deletion - the group disappears from the tree view.
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The File Menu

Figure 5-1.Vision Viewerwith opened File Menu

This is the File Menu, it is very short only allowing you to exit theVision Viewer.

Note: When you con�gure a Raritan device, then the device stores it s con�guration locally. But of
course the Vision Viewer stores some of its own data, like your user preferences. These are
currently stored in the Windows Registry, normally under the following key:
HKCU\Software\Peppercon AG\KVM Vision Viewer . The key might be different if you are using an
OEM version of our products. Using REGEDIT or a registry editor of your choice you can then get
the con�guration information out of the registry and import it onto another machine if you want to run
the Vision Viewer with "your" settings there.
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The Con�guration Menu

Figure 5-2.Vision Viewerwith opened Con�guration Menu

Using this drop-down menu allows you to con�gure the behaviour of Vision Viewer, the options for the
remote console windows and of course you can �nd and con�gureall of the Raritan Remote
Management Devices (RMDs) on your network. The above screenshot shows theVision Viewerwith the
opened con�guration menu.

Find New Devices
Use the "Find New Devices" menu item in order to start lookingfor new devices. Once you have done
this the newly found devices will show up under the "Uncon�gured Devices" group in the tree view.
They are displayed using the Ethernet/MAC address only. This is because they are not known to the
Vision Viewer.

Normally, or rather very often, customers have a DHCP servercon�gured on their LAN. Our RMDs
usually are shipped with the DHCP boot option being enabled (this may not be the case if you speci�ed
otherwise in case you are an OEM customer). In other words, once the RMD is powered up it will
receive an IP-address and other information pertaining to the network from your DHCP server.

However when you start up theVision Viewer, you will �nd that the RMDs detected by theVision Viewer
are placed in a default group called "Uncon�gured Devices".They are shown in the tree view by their
Ethernet MAC address -despite the fact that they are already "equipped" with an IP-addressusing
DHCP. But theVision Viewerdoes not yet "know" the device. Therefore, the RMD is shown inthe
"Uncon�gured Devices" group in the tree view of theVision Viewer. They are clearly marked with
yellow question mark.
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In order to get to know the device theVision Viewerhas to either "query" the device or "con�gure" it.
These are menu options of theVision Viewerwhich are discussed in the later chapters. Querying the
device will check if it already has an IP-address. Con�guring the device will allow you to either set an
individual IP-address or instruct the RMD to fetch one from the DHCP server.

Once the RMD has been queried or con�gured, it will have an IP-address in the tree view. It will also
move immediately from theUncon�gured Devices group to become a member of theNew Devices
group. Therefore do not worry if devices suddenly "vanish" -they are not lost, just in a different view of
the tree view.

Figure 5-3. Find New Device (Results of Search)

When you select this item theVision Viewerwill start seeking out Raritan Devices on your network and
display them. You will see their MAC (Ethernet Hardware Address).

Normally these devices are marked with a "?" as unknown or uncon�gured and appear in the
Uncon�gured Devices group. This means that you can then con�gure them using theVision Viewer's
menus.
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The Options Menu
In order to con�gure theVision Viewerand the remote console settings, please use the Options menu
item.

Figure 5-4. Con�guration Options Drop-Down Menu
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Figure 5-5.Vision ViewerCon�guration Options Pop-Up

TheVision ViewerPreferences pop-up shown above offers several parameters you can tailor to your
liking:

• Registry Settings- are shown on the left hand sideVision Viewercon�guration data is generally
stored in the Windows Registry. By clicking the �eld "Save Groups and Devices in Registry" you can
also store your Raritan RMD device con�gurations and your administrative groups in the Registry. The
large "Delete..." button below will clear all of this data out of the Registry, allowing you to "start over".

Please note that if you decide to not store your settings in the registry, theVision Viewerwill always
start up with a "clean slate". You will then �nd no devices or groups on display in the tree view. You
then have to start �nding, querying and con�guring your devices anew.

• Web Browser - the Web Browser area of theVision Viewerallows you to select either your
pre-con�gured standard browser or you can choose one of yourown. If you wish to choose your own,
then you will �nd the dialogue box enabled, where you can browse your PC to choose the browser you
wish.

• Default Connection Options- with the following option you can use the drop-down menu shown
below to set the display parameters for theRCwindow. This applies to theRCwindow in the
Observation Window as well as in the Extra Window.
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Figure 5-6. Connection Mode Drop-Down Menu

• Observation Windows Settings- This drop-down menu allows you to tell theVision Viewerwhat
quality picture you wish to see in the Observation Window.

Figure 5-7. Video Quality Drop-Down Menu

The "Minimize ..." toggle button allows to con�gure theVision Viewerbehavior, when you open a new
Extra Window for theRC. When you enable this option, the mainVision Viewerwindow will be
minimized into your Windows Application Tray as soon as you open anRCwindow (in an Extra
Window).
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• Observation Window Click Behavior - controls the behaviour of the Observation Window when you
click the window. Normally (and this is the marked default) you want to enable the option "Open
Connection to Device in New Window". As soon as you move your mouse over the Observation
Window, your cursor will change into the "hand" shape, that is familiar to you from web sites or the
Acrobat Reader. If you then use this "hand" to click the Observation Window theRCwill be opened in
an Extra Window.

Enabling "Remote Control" will also connect your keyboard and mouse to the remote system.

Finally you can also choose that the mouse click will do nothing and you only want to see the monitor
output in the window and nothing else. This is actually quiteuseful if you just want to quickly look at
some console output etc.
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Remote Console Preferences Menu
The drop-down Con�guration Menu shows the "Remote Console Preferences Menu" underneath the
previously discussed "Options" menu.

This menu item opens another pop-up. It allows you to con�gure the look and behaviour of the Remote
Console window to a �ner degree.

Figure 5-8. Con�guration Preferences Menu

The above pop-up window allows the following settings:
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• Tool Tips Help - this allows you to enable or disable the dynamic help menus.Also you can adjust the
form of the help, the default being the normal "ballon" look.

Figure 5-9. Remote Console Style Preferences

• Full Screen Message- this controls a helpful Message Box giving you a hint on how to leave the
Extra Window, in case you have selected Full Screen mode. When the Extra Window of theRC�lls
the entire screen, then the buttons to close or control it arenot visible. TheAlways setting will allow
the hint ("Press Ctrl-F10...") to be displayed in a pop-up box. Nevermeans that you never wish to see
the Message Box.Skip on Hotkey or Toolbar displays the hotkey hint only if you opened the Full
Screen Extra Window using the menu. If you opened the Full ScreenRCusing the Toolbar or Hotkey,
then the hint will not appear.

• Saving Session Preferences- theVision Viewersaves some of its & rc con�guration settings in the
Registry. Using this option you save the settings pertaining to your remote session, for example
display and mouse settings.

Note: These are saved for each device. The Vision Viewer will remember the RC preferences and
settings for each RMD.
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• Special Windows Keys Behaviour- Windows knows some special key codes, like CTRL-ALT-DEL
etc. This option controls how theVision Viewerwill deal with them. The default is that special keys
get handled by the local PC and will not be transmitted to the Remote Host. The other points allow
you to transmit them to the remote host or both.

• Show Toolbar - simply choose whether you want to permanently see the tool bar.

• Status Bar - toggle if you wish to see the status bar or not.

• Rendering Options- this controls the rendering of the images from the remote device in the
Observation Window or Extra Window. The problems arise if weneed to scale the image received up
or down for display on your PC. Bear in mind that the remote system might have a larger or smaller
screen than your PC.

Basically you will encounter two situations: either you want to open theRCand scale the picture up or
down in order to �t your screen for example OR you simply want to see theRCone-to-one.

For the latter case you should "Use 2D Rendering": this meansthat theRCwill use the Microsoft
Windows Software rendering functions to render the image. This is actually fastest, given that you do
not need any image scaling.

For scaling you should "Use Direct 3D" - however this needs a powerful graphics card to work nicely.
If you have a slow PC but a fast graphics card, this is the best option. However please note that it is
fastest only for a SINGLE remote device display.

Or you can "Use Software Rendering" - this setting enables some very fast propietary Raritan scaling
code to be used. The image painting is then handled by the Windows operating system. In order to
achieve good performance you really need a fast PC for this option, but you can use it well for viewing
severalRCwindows at once.

• Proxy Settings- by clicking the CHANGE PROXY SETTINGS button you will �nd a pop-up menu
to change the settings for the Web Browser proxy.

Proxy settings are necessary because theVision Vieweruses the HTTP (Web) Protocol to establish the
initial connection to the RMD. Furthermore theVision Vieweruses the HTTPS (Secure Web) port
number 443 (the default) in order to authenticate theRCuser. Once the connection is established the
RMDs still use the same ports to transmit our own propietary protocols because they are usually
allowed to be used through �rewalls and proxies within a company.
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Figure 5-10. Proxy Settings

• Reset to Defaults- if you regret all your playing around with all the options, this button allows you to
return to our factory defaults. Instant sanity at the click of a button :-)
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Show Tree View Item
Of course you can also switch the tree view off or on (the default), as the next two screenshots illustrate.

Figure 5-11. Tree View Off

Figure 5-12. Tree View On
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IPMI Connections
Some devices are also accessible using IPMI. In fact some RMDs allow ONLY IPMI connections.

Note: In order to access IPMI RMDs, these have to adhere to the IPMI 2.0 standard and allow IPMI
over Ethernet. The Vision Viewer does not support IPMI over other media.

Figure 5-13. Selecting the IPMI Frontend

When the IPMI Frontend is opened using the above screen, you will �rst see an initial screen, this is
NOT yet connected. You �rst need to enter some information sothat theVision Viewercan establish an
IPMI connection to the RMD:
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Figure 5-14. Enter IPMI Connection Parameters Pop-Up

Figure 5-15. Effect of closing the IPMI Frontend
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When you close the IPMI Frontend you will see an idle and emptyVision Viewer.

Figure 5-16. Enabling IPMI 2.0

IPMI Frontend with IPMI 2.0 enabled. This allows you to connect to the RMD using IPMI over the
Ethernet. Normally IPMI uses the Management Bus or a serial connection.
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Figure 5-17. IPMI 2.0 disabled

And with disabled IPMI 2.0

60



Chapter 5. Con�guring the KVM Vision Viewer

IPMI in Detail
IPMI is a vastly complex architecture and to fully explain itwould certainly breach the scope of this
manual. Therefore we will just give a brief overview of the IPMI facilities available using theVision
Viewer. If you are not using IPMI feel free to skip this section. If you are using IPMI however, we are
assuming that you are familiar with most basic IPMI concepts.

Figure 5-18. IPMI - BMC Info Pop-Up

The above pop-up will give you information pertaining to your BMC. Additionally you may restart the
BMC either warm or cold. A restart will break your IPMI connection and you have to restart.
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Figure 5-19. IPMI Chassi Control

The IPMI Chassis interface will allow you to �nd out status information, like the current state of being
powered up, the uptime etc.. On top of that you can control thepower supply remotely.

The "Choose Locator" area of the menu allows you to control a front panel LED which you can turn on
in case you need to �nd the remote host physically in a rack full of many servers.
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Figure 5-20. IPMI Boot Policy and Power-Up Behavior

The boot policy screen allows you to specify certain optionsfor booting the remote host. You might for
example only wish to boot from the CD-ROM or only until the boot process reaches the BIOS because
you might want to change some BIOS parameters etc.

The right side of this screen will allow you to specify how thesystem should behave in case the power
fails abnormally and comes back on.
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Using the System Event Log

Figure 5-21. System Event Log Frontend

The BMC generates messages into the System Event Log (SEL) and the screen above lets you look into
the log.
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Figure 5-22. Selecting SEL Custom Function

You can either select to see all of the SEL entries or you can specify a custom �lter functions. As you can
see from the drop down menu you can narrow the range of displayed entries time wise. CUSTOM allows
you to specify a time range in the date and time �elds of the window.

When you change the selection you need to press the QUERY SYSTEM EVENT LOG button!
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Figure 5-23. Viewing the Details of a Highlighted SEL Entry

When you select an SEL entry, you can easily get a more detailed view by clicking the DETAILS ON
SELECTED ENTRY button.
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Accessing Sensors using IPMI

Figure 5-24. Enquiring Sensors using IPMI

You can select to see the state of the sensors on the remote hosts motherboard and chassis using this
function.
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Figure 5-25. Detailed Sensor View

A more detailed view of the sensor is also available.
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The Device Menu
This drop-down menu allows you to con�gure the newly found devices and allows you to con�gure and
establish a connection to it. Note that the most commonly used menu entries are also available as a
short-cut in theVision Viewertask bar.

You have two ways of accessing the Device Menu: either use thedrop-menu from theVision Viewer
menus or use the right-click of the mouse on the device in question to open the same menu as the
following two screen shots show:

Figure 6-1. Device Drop-Down Menu
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Figure 6-2. Con�gure Device Menu Right Button Pop-Up

Note: Using the right button also allows you to select a whole group of devices by right-clicking the
group name in the tree view.

Initial Con�guration of RMDs
After theVision Viewerhas found new devices, you will �rst see them in the tree view with their MAC
address. You usually then want to do an initial con�gurationin order to set basic parameters for the
device.
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Figure 6-3. Selecting Initial Device Setup

The above screen shows the pop-menu you see when you right-click the device. You should select
"Initial Device Setup" in order to reach the setup screen.

Note: This function is also available using the Initial Device Setup menu item.
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Figure 6-4. Initial Device Setup Screen
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Figure 6-5. Initial Device Setup Help Button

You might actually �nd the HELP button very useful here. It displays some information, generally you
want to query the RMD �rst. Press the QUERY DEVICE button.
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Figure 6-6. Initial Device Setup Help Pop-Up

Figure 6-7. Querying the RMD
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After the Query you will see some properties of the device in the box above: the MAC address, the
Device Type as well the default method (DHCP) the RMD uses to receive an IP address.

Figure 6-8. Login as the Administrative User

You can login to the device by typing the administrative login. The default settings of the administrative
user are mentioned in the Device Manual of your Raritan RMD. Every RMD has different settings.
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Figure 6-9. RMD with IP-Address

Once you are satis�ed that you have set the correct parameters press the SETUP DEVICE button to
�nish the setup:

Figure 6-10. Setup Device Con�rmation
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The Device Con�guration Wizard
You may also use the Device Con�guration Wizuard to help you setting up the RMD. The Wizard is
designed to quickly guide you through the steps of the setup process.

Note: You can also invoke the wizard by double-clicking the device with the left mouse button in the
tree view as long as the device is shown in the Uncon�gured Dev ices group. If you double-click on a
device in the New Devices group, you will open a RC in an Extra Window.

Figure 6-11. Selecting the Device Wizard Pop-Up
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Figure 6-12. Device Con�guration Wizard Greeting Screen

This is the Device Wizard's introductory screen. Just clickNEXT to continue.
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Figure 6-13. Wizard Change Super-User Password Screen

For security reasons the Wizard will allow you to change the super-user password.

Note: We STRONGLY recommend that you change the password.

It might suit you to generate passwords according to an algorithm, as you will soon have lots of
RMDs to take care of. For security reasons every RMD should have its own password. If your
algorithm (as an example) includes information like the month, the name of the RMD and a part of its
IP-address, then you have cyclical passwords that are unique. Having the knowledge of this
algorithm makes it easy for you to know the password of every RMD. Try it, you might like it! And do
not forget to change the passwords regularly then too.
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Figure 6-14. Wizard Network Con�guration Screen

You can choose that the RMD will learn about its network con�guration using a DHCP server. If you
have no DHCP server or you need a special con�guration you canadjust the network parameters
manually.
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Figure 6-15. Device Con�guration Wizard Connection Options Screen

You are almost done, here you set some basic properties for the connection. This was explained earlier in
this chapter.
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Figure 6-16. Device Con�guration Wizard Final Screen

You are done. If you wish to immediately connect to theRCthen please tick the box before you click
FINISH.
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Managing Devices
The �rst two options of the drop-down Device Menu allow you tocreate a new device or delete it:

Figure 6-17. Selecting the New Device Option
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Figure 6-18. Deleting a Selected Device

Note: When the "screen" of the RMD is colored red it means there is no connection to it active. A
green screen means that there are connections active to the RMD and/or there is a RC open using
this RMD. A yellow screen means that a remote connection is currently being set up.

Sometimes you can see a tiny �oppy disk symbol displayed next to the device. This is to show you
that there is also a Drive Redirection active to the device.

Querying the Device
Querying the device will show the properties of the device. Also it will be "moved" from the
Uncon�gured Devices tree to theNew Devicestree in the tree view. This action is available either
from the Device drop-down menu or by right-clicking the device as shown below:
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Figure 6-19. Query Device Menu Option
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Figure 6-20. Device Change Connection Settings Pop-Up

Here is the result of querying the device and selecting the "Change Connection Settings" item. The name
is set to the Raritan name of the device, you may change it to something more mnemonic if you wish.
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Changing the Connection Settings

Figure 6-21. Selecting the Change Connection Settings Option

This menu item is used to change the settings of the remote connection. The �elds to be set are fairly
self-explanatory. (See Chapter 6.)

Figure 6-22. Change Connection Settings Pop-Up
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Connect in Observation Window
Use the following menu item to connect to the remote host, i.e. the machine that "hosts" the RMD. The
Observation Window is the large gray panel visible to the right of the tree view (if you have enabled the
tree view). In case you have disabled the tree view, the Observation Window will �ll the entire Vision
Viewerwindow. Note that you can also open aRCin a different new window and can also use a full
screenRC. This was explained in detail in Chapter 3The Remote Console: Care and Feeding.

Figure 6-23. Selecting Connect in Observation Window Option

Note: You can open the RC to SEVERAL RMDs in the Observation Window. This is very useful if
you wish to "keep an eye" on several systems until you notice something which requires your closer
attention.
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Figure 6-24. Selecting Disconnect from Observation Window

Of course you may also disconnect at leisure using the above option. When you have disconnected in an
orderly fashion you will see an empty Observation Window:
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Figure 6-25. Idle Observation Window

Observation Control
This menu allows you to control the parameters of the Observation Window.

Note: Please remember that this menu is only activated if you have set the option "Observation
Window Click Behavior" to the value "Enable Remote Control". Please see Chapter 5 for details.
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Figure 6-26. Observation Window Settings

Monitor Only - this button connects theRCto the remote host for video only. The input devices
(keyboard and mouse) are ignored.

Exclusive Access -this is necessary if you need to be alone with your remote host. Our RMDs allow
several admins to be logged on at the same time, but if you wishto do something critical, you usually
want to be the only user on the RMD. Clicking this button will make you the only user on the RMD. It is
a good idea to warn the other users, in case they themselves are doing something important. Clicking this
button without prior warning is de�netely considered rude!
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Figure 6-27. Observation Window Refresh Rate Drop-Down Menu

Auto Refresh - this option is useful in conjunction with the Noise Filter. When you increase the effect of
the Noise Filter, the screen painting may be slow and you might see artefacts (esp. shadows of the mouse
pointer) in theRC. Setting this refresh rate will repaint the picture and "erase" resp. avoid such artefacts.

Drive Redirection
Device Redirection is a method for virtual media. It allows you to map or "connect" one of the local
drives (i.e. in your PC) to connect to the remote system. Thisway you can for example boot the remote
computer using a CD-ROM that is inserted into your PC.
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Figure 6-28. Selecting Drive Redirection

As soon as you move the mouse over the menu item, a small sub-menu pops out. This allows you to
select the source of the local drive to connect. In our example case, we only have a Local Drive. You can
also change the Redirection Settings:
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Figure 6-29. Drive Redirection Sub-Menu

If you have successfully connected the virtual drive, you will see the following screen with more enabled
options.
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Figure 6-30. Successful Drive Redirection

Figure 6-31. Terminating Drive Redirection
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You may disconnect the Drive Redirection.

Figure 6-32. Successful Drive Redirection Disconnect

Connect in Extra Window
As mentioned before, you may decide that theVision Viewer's Observation Window is too small for
comfort. Therefore you might want to open a new window for theRCconnection. Such a new window
can be resized, minimized and enlarged like your usual desktop windows.

Use the following option to open a connection in a new window:
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Figure 6-33. Connect in Extra Window

Again you may disconnect, but you have to do this in the new window that you just created. If you only
open a connection in the Observation Window then obviously you disconnect in that window.
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Figure 6-34. Disconnecting in the Extra Window

The following option allows you to set the new window parameters before connecting.
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Figure 6-35. Selecting Advanced Mode for the Connection in an Extra Window

Figure 6-36. Advanced Mode Connection Options Pop-Up

The familiar Connection Options pop-up is visible. It offers two buttons for more options as follows.
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Figure 6-37. Advanced Connection Options Button Menu

When you select the Connection Options, you will see the above pop-up menu. You can select the
preferred encoding of the video data. TheRCcan either detect this automagically or you can set a �xed
encoding. If you choose to �x your own method you can also set the connection parameters in a more
detailed fashion by selecting the ADVANCED option.

You can also select Exclusive Access for yourRCconnection. As mentioned above, this will make you
the only user accessing the remote RMD.

Using the RESET TO FACTORY DEFAULTS button you can easily restore some sane values in case
you made a mistake in the con�guration.
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Figure 6-38. Advanced Connection Display Options Button Menu

These display options are fully explained in the following Chapter 6The Remote Console Con�guration
and Options.

Figure 6-39. Authentication Settings

You can choose different authentication parameters.

Note: Note that we strongly recommend using HTTPS connections to encrypt your passwords etc.

101



Chapter 6. Con�guring the Devices

Con�gure Web Access for the Device

Figure 6-40. Con�guring Web Site Access Parameters

All RMDs have a built-in web access. In other words: you may point your normal web browser at the
RMD's IP address and you will be able to administer the RMD.

Figure 6-41. Web Access Certi�cate Query
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The RMD web access will ask you to accept a security certi�cate. Generally you should accept our
certi�cate.

Figure 6-42. Web Access Login Screen

This is the login screen to the RMD. The login parameters (name/password) may be different for your
RMD, depending on which RMD you use or if you are using an OEM version of our products. Please
consult your Device Manual speci�c to your RMD for details.

Note: It might suit you to generate passwords according to an algorithm, as you will soon have lots of
RMDs to take care of. For security reasons every RMD should have its own password. If your
algorithm (as an example) includes information like the month, the name of the RMD and a part of its
IP-address, then you have cyclical passwords that are unique. Having the knowledge of this
algorithm makes it easy for you to know the password of every RMD. Try it, you might like it! And do
not forget to change the passwords regularly then too.
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Figure 6-43. Web Access Home Page

When you have successfully logged in, you will already see the web interface as well as a remote
console window in your browser.
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Figure 6-44. Example Con�guration Screen using the Web Interface

You can access several administrative functions. These aredescribed in more detail in the user manuals
relevant to the device you are connecting to. They are not part of this manual.

The Help Menu
The Help option will display information about theVision Viewer.
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Figure 6-45. Selecting Help Menu

Figure 6-46. About KVM Vision Viewer Info Box
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ACPI

Advanced Con�guration and Power Interface

A speci�cation that enables the operating system to implement power management and system
con�guration.

ATX

Advanced Technology Extended

A particular speci�cation that covers the style of motherboards and enclosure introduced by Intel in
1995.

DHCP

Dynamic Host Con�guration Protocol

A protocol for dynamically assigning IP con�gurations to host names, especially used in a local
network.

DNS

Domain Name System

A protocol used to locate computers on the Internet by their name.

FAQ

Frequently Asked Questions

HTTP

Hypertext Transfer Protocol

One of the protocols used for communication between single computers, especially between web
browsers and web servers.

HTTPS

Hypertext Transfer Protocol Secure

The secure version of HTTP.

IPMI

Intelligent Platform Management Interface

A speci�cation de�ning a set of common interfaces for operating system independent platform
management and health monitoring.

LED

Light Emitting Diode

A semiconductor device that emits incoherent monochromatic light when electrically biased in the
forward direction.

107



Appendix A. Glossary

PS/2

Personal System/2

IBM's second generation of personal computers, which was released to the public in 1987. Today,
PS/2 is known as a device interface for mouse and keyboard.

SNMP

Simple Network Management Protocol

A widely used network monitoring and control protocol.

SSH

Secure Shell

An encrypted network protocol providing a secure replacement for Telnet.

SSL

Secure Socket Layer

An encryption technology for the Internet used to provide secured data transmissions.

SVGA

Super Video Graphics Array

A re�nement of the Video Graphics Array (VGA) that provides increased pitch and resolution
performance.

UTP

Unshielded Twisted Pair

A cable with two conductors twisted as a pair and bundled within the same outer PVC covering.
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Table B-1shows the key codes used to de�ne the key strokes or hotkeys for several functions. Please
note that these key codes do not necessarily represent the key characters that are used on international
keyboards. A key on a standard 104 key PC keyboard with a US English language mapping is named.
The layout for this keyboard is shown inFigure B-1. However, most modi�er keys and other
alphanumeric keys used for hotkey purposes in application programs are on a similar position, no matter
what language mapping you are using. Some of the keys also have aliases. This means that a key can be
named by two different key codes.

Figure B-1. English (US) keyboard Layout, used for the key codes

Table B-1. Key Names

Key Alias Key(s)

0 - 9

A - Z

~ TILDE

_ MINUS

= EQUALS

;

'

< LESS

,

.

/ SLASH

BACKSPACE

TAB

[

]

ENTER

CAPS LOCK

\ BACK SLASH

LSHIFT SHIFT
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Key Alias Key(s)

RCTRL CTRL, STRG

RSHIFT SHIFT

LCTRL CTRL, STRG

LALT ALT

SPACE

ALT GR

ESCAPE ESC

F1

F2

F3

F4

F5

F6

F7

F8

F9

F10

F11

F12

PRINTSCREEN

SCROLL LOCK

BREAK

INSERT

HOME POS 1

PAGE_UP

PAGE_DOWN

DELETE DEL

END

UP

LEFT

DOWN

RIGHT

NUM_LOCK

NUMPAD0

NUMPAD1

NUMPAD2

NUMPAD3

NUMPAD4

NUMPAD5

NUMPAD6
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Key Alias Key(s)

NUMPAD7

NUMPAD8

NUMPAD9

NUMPADPLUS NUMPAD_PLUS, +

NUMPAD / /

NUMPADMUL NUMPAD_MUL, x

NUMPADMINUS NUMPAD_MINUS, -

NUMPADENTER

WINDOWS

MENU
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Appendix C. Raritan Inc. Warranty Information

Limited Warranty
Raritan Inc. manufactures its hardware products from parts and components that are new or equivalent
to new in accordance with industry-standard practices. Raritan warrants that the hardware products
including the �rmware will be free from defects in materialsand workmanship under normal use. Any
implied warranties on the Raritan �rmware and hardware are limited to 24 months, respectively,
beginning on the date of invoice. Some states/jurisdictions do not allow limitations on duration of an
implied warranty, so the above limitation may not apply to you. Additionally Raritan grants a special
warranty for 6 months.

Customer Remedies
Raritan's entire liability and exclusive remedy shall be, at Raritan's option, either (a) return of the price
paid, or (b) repair or replacement of the �rmware or hardwarethat does not meet this Limited Warranty
and which is returned to Raritan with a copy of your receipt. Damage due to shipping the products to you
is covered under this warranty. Otherwise warranty does notcover damage due to external causes,
including accident, abuse, misuse, problems with electrical power, servicing not authorized by Raritan ,
usage not in accordance with product instructions, failureto perform required preventive maintenance
and problems caused by use of parts and components not supplied by Raritan . Any replacement
hardware will be warranted for the remainder of the originalperiod or thirty (30) days, whichever is
longer. Raritan will repair or replace products returned toRaritan's facility. To request warranty service
you must inform Raritan within the warranty period. If warranty service is required, Raritan will issue a
Return Material Authorization Number. You must ship the products back to Raritan in their original or an
equivalent packaging, prepay shipping charges, and insurethe shipment or accept the possibility of loss
or damage during shipment.

No Other Warranties
To the maximum extend permitted by applicable law, Raritan disclaim all other warranties, either express
or implied, including, but not limited to implied warranties of merchantability and �tness for a particular
purpose, with regard to the �rmware, the accompanying written materials, and any accompanying
hardware. This limited warranty gives you speci�c legal rights. You may have others, which vary from
state/jurisdiction to state/jurisdiction.

No Liability For Consequential Damages
To the maximum extent permitted by applicable law, in no event shall Raritan be liable for any damages
whatsoever (including without limitation, special, incidental, consequential or indirect damages for
personal injury, loss of business information, or any otherpecuniary loss) arising out of the use of or
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Appendix C. Raritan Inc. Warranty Information

inability to use this product, even if Raritan has been advised of the possibility of such damages. In any
case, Raritan's entire liability under any provision of this agreement shall be limited to the amount
actually paid by you for the �rmware and/or hardware. Because some states/jurisdictions do not allow
the exclusion or limitation of liability for consequentialor incidental damages, the above limitation may
not apply to you.
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Appendix D. GNU General Public License (GPL)
Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA
02111-1307 USA Everyone is permitted to copy and distributeverbatim copies of this license document,
but changing it is not allowed.

Preamble

The licenses for most software are designed to take away yourfreedom to share and change it. By
contrast, the GNU General Public License is intended to guarantee your freedom to share and change
free software--to make sure the software is free for all its users. This General Public License applies to
most of the Free Software Foundation's software and to any other program whose authors commit to
using it. (Some other Free Software Foundation software is covered by the GNU Library General Public
License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are
designed to make sure that you have the freedom to distributecopies of free software (and charge for this
service if you wish), that you receive source code or can get it if you want it, that you can change the
software or use pieces of it in new free programs; and that youknow you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask
you to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute
copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the
recipients all the rights that you have. You must make sure that they, too, receive or can get the source
code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which
gives you legal permission to copy, distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain that everyone understands that there
is no warranty for this free software. If the software is modi�ed by someone else and passed on, we want
its recipients to know that what they have is not the original, so that any problems introduced by others
will not re�ect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that
redistributors of a free program will individually obtain patent licenses, in effect making the program
proprietary. To prevent this, we have made it clear that any patent must be licensed for everyone's free
use or not licensed at all.

The precise terms and conditions for copying, distributionand modi�cation follow.

GNU GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright
holder saying it may be distributed under the terms of this General Public License. The "Program",
below, refers to any such program or work, and a "work based onthe Program" means either the Program
or any derivative work under copyright law: that is to say, a work containing the Program or a portion of
it, either verbatim or with modi�cations and/or translatedinto another language. (Hereinafter, translation
is included without limitation in the term "modi�cation".)Each licensee is addressed as "you".
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Activities other than copying, distribution and modi�cation are not covered by this License; they are
outside its scope. The act of running the Program is not restricted, and the output from the Program is
covered only if its contents constitute a work based on the Program (independent of having been made
by running the Program). Whether that is true depends on whatthe Program does.

1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any
medium, provided that you conspicuously and appropriatelypublish on each copy an appropriate
copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to
the absence of any warranty; and give any other recipients ofthe Program a copy of this License along
with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer
warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based
on the Program, and copy and distribute such modi�cations orwork under the terms of Section 1 above,
provided that you also meet all of these conditions:

a. You must cause the modi�ed �les to carry prominent noticesstating that you changed the �les and
the date of any change.

b. You must cause any work that you distribute or publish, that in whole or in part contains or is
derived from the Program or any part thereof, to be licensed as a whole at no charge to all third
parties under the terms of this License.

c. If the modi�ed program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an
announcement including an appropriate copyright notice and a notice that there is no warranty (or
else, saying that you provide a warranty) and that users may redistribute the program under these
conditions, and telling the user how to view a copy of this License. (Exception: if the Program itself
is interactive but does not normally print such an announcement, your work based on the Program is
not required to print an announcement.)

These requirements apply to the modi�ed work as a whole. If identi�able sections of that work are not
derived from the Program, and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply tothose sections when you distribute them as
separate works. But when you distribute the same sections aspart of a whole which is a work based on
the Program, the distribution of the whole must be on the terms of this License, whose permissions for
other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by
you; rather, the intent is to exercise the right to control the distribution of derivative or collective works
based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a
work based on the Program) on a volume of a storage or distribution medium does not bring the other
work under the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or
executable form under the terms of Sections 1 and 2 above provided that you also do one of the
following:
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a. Accompany it with the complete corresponding machine-readable source code, which must be
distributed under the terms of Sections 1 and 2 above on a medium customarily used for software
interchange; or,

b. Accompany it with a written offer, valid for at least threeyears, to give any third party, for a charge
no more than your cost of physically performing source distribution, a complete machine-readable
copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above
on a medium customarily used for software interchange; or,

c. Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer,in accord with Subsection b above.)

The source code for a work means the preferred form of the workfor making modi�cations to it. For an
executable work, complete source code means all the source code for all modules it contains, plus any
associated interface de�nition �les, plus the scripts usedto control compilation and installation of the
executable. However, as a special exception, the source code distributed need not include anything that is
normally distributed (in either source or binary form) withthe major components (compiler, kernel, and
so on) of the operating system on which the executable runs, unless that component itself accompanies
the executable.

If distribution of executable or object code is made by offering access to copy from a designated place,
then offering equivalent access to copy the source code fromthe same place counts as distribution of the
source code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under
this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and
will automatically terminate your rights under this License. However, parties who have received copies,
or rights, from you under this License will not have their licenses terminated so long as such parties
remain in full compliance.

5. You are not required to accept this License, since you havenot signed it. However, nothing else grants
you permission to modify or distribute the Program or its derivative works. These actions are prohibited
by law if you do not accept this License. Therefore, by modifying or distributing the Program (or any
work based on the Program), you indicate your acceptance of this License to do so, and all its terms and
conditions for copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient
automatically receives a license from the original licensor to copy, distribute or modify the Program
subject to these terms and conditions. You may not impose anyfurther restrictions on the recipients'
exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties to
this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason
(not limited to patent issues), conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License,they do not excuse you from the conditions of
this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License
and any other pertinent obligations, then as a consequence you may not distribute the Program at all. For
example, if a patent license would not permit royalty-free redistribution of the Program by all those who
receive copies directly or indirectly through you, then theonly way you could satisfy both it and this
License would be to refrain entirely from distribution of the Program.
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If any portion of this section is held invalid or unenforceable under any particular circumstance, the
balance of the section is intended to apply and the section asa whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringeany patents or other property right claims or
to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the
free software distribution system, which is implemented bypublic license practices. Many people have
made generous contributions to the wide range of software distributed through that system in reliance on
consistent application of that system; it is up to the author/donor to decide if he or she is willing to
distribute software through any other system and a licenseecannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this
License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by
copyrighted interfaces, the original copyright holder whoplaces the Program under this License may add
an explicit geographical distribution limitation excluding those countries, so that distribution is permitted
only in or among countries not thus excluded. In such case, this License incorporates the limitation as if
written in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License
from time to time. Such new versions will be similar in spiritto the present version, but may differ in
detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program speci�es a version number of this
License which applies to it and "any later version", you havethe option of following the terms and
conditions either of that version or of any later version published by the Free Software Foundation. If the
Program does not specify a version number of this License, you may choose any version ever published
by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into otherfree programs whose distribution
conditions are different, write to the author to ask for permission. For software which is copyrighted by
the Free Software Foundation, write to the Free Software Foundation; we sometimes make exceptions
for this. Our decision will be guided by the two goals of preserving the free status of all derivatives of our
free software and of promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY
FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES
PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK
AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE
PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING,
REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TOIN WRITING
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR
DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM(INCLUDING
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BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR
LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO
OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible use to the public, the best
way to achieve this is to make it free software which everyonecan redistribute and change under these
terms.

To do so, attach the following notices to the program. It is safest to attach them to the start of each source
�le to most effectively convey the exclusion of warranty; and each �le should have at least the
"copyright" line and a pointer to where the full notice is found.

This program is free software; you can redistribute it and/or modify it under the terms of the GNU
General Public License as published by the Free Software Foundation; either version 2 of the License, or
(at your option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY;
without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR
PURPOSE. See the GNU General Public License for more details.

You should have received a copy of the GNU General Public License along with this program; if not,
write to the Free Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it starts in an interactive mode:

Gnomovision version 69, Copyright (C) year name of author Gnomovision comes with ABSOLUTELY
NO WARRANTY; for details type "show w". This is free software, and you are welcome to redistribute
it under certain conditions; type "show c" for details.

The hypothetical commands "show w" and "show c" should show the appropriate parts of the General
Public License. Of course, the commands you use may be calledsomething other than "show w" and
"show c"; they could even be mouse-clicks or menu items-- whatever suits your program.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a
"copyright disclaimer" for the program, if necessary. Hereis a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest inthe program "Gnomovision" (which makes
passes at compilers) written by James Hacker.

This General Public License does not permit incorporating your program into proprietary programs. If
your program is a subroutine library, you may consider it more useful to permit linking proprietary
applications with the library. If this is what you want to do,use the GNU Library General Public License
instead of this License.
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Appendix E. The OpenLDAP Public License
Version 2.8, 17 August 2003

Redistribution and use of this software and associated documentation ("Software"), with or without
modi�cation, are permitted provided that the following conditions are met:

1. Redistributions in source form must retain copyright statements and notices,

2. Redistributions in binary form must reproduce applicable copyright statements and notices, this list
of conditions, and the following disclaimer in the documentation and/or other materials provided
with the distribution, and

3. Redistributions must contain a verbatim copy of this document.

The OpenLDAP Foundation may revise this license from time totime. Each revision is distinguished by
a version number. You may use this Software under terms of this license revision or under the terms of
any subsequent revision of the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITSCONTRIBUTORS
"AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING,BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OPENLDAP
FOUNDATION, ITS CONTRIBUTORS, OR THE AUTHOR(S) OR OWNER(S)OF THE SOFTWARE
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCEOR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

The names of the authors and copyright holders must not be used in advertising or otherwise to promote
the sale, use or other dealing in this Software without speci�c, written prior permission. Title to
copyright in this Software shall at all times remain with copyright holders.

OpenLDAP is a registered trademark of the OpenLDAP Foundation.

Copyright 1999-2003 The OpenLDAP Foundation, Redwood City, California, USA. All Rights
Reserved. Permission to copy and distribute verbatim copies of this document is granted.
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